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1 Introduction

Arkitex Courier is a file transmission system that, while it is designed to transmit, 
control, and track pages, focuses on individual files. These files may be layers of 
a page, or they may be other types of files such as ads or files containing plate 
components. Courier does provide a number of page-based interface features 
such as thumbnails and page approval; but Courier is file-based. Courier does 
not display any sheet-based interfaces.

Using various planning tools such as Arkitex Planner, Publication Builder, or 
AutoPlan, editorial sites can create publication plans and transmit them using 
Courier to single and multiple sites. These plans are in an XML format.

Through various views the status of each file transmission can be monitored. 
Available views include Tracking, Thumbnails, Details, Files, Destinations, and 
Queue View (within the Destinations view). Filtering is also available. 

Tracking and details emphasize transmission rather than imaging. Soft Proof 
display is available in Printer Pair, Reader Pair, and Single View.

Arkitex Courier Documentation

All documentation may be found on the Arkitex Workflow Products DVD.

Getting Started Click the Documentation button, and select View Documentation to display a 
complete listing of documentation in PDF format.

Related topics: ■ Arkitex Courier Installation Guide

■ Arkitex Courier System Administration Guide

■ Arkitex Client Reference Guide (online help for the Courier Client)

■ “Arkitex Planner” on page 59

■ Arkitex Workflow Release Notes
9
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2 Client

This chapter explains the layout and features of Courier Client for all users. 

Log In/Log Out

Once the Client has been installed, it can be activated by opening the Internet 
browser.

e.g., http://ArkitexCourier_server

The following Internet browsers are supported:

NOTE: Mac Users - Client screens use the Mac look-and-feel, including methods 
of multiple selection, and pop-up menus. On Macs, shift-click is used for multiple 
selection, and control-click is used to access pop-up menus.

How to Log In At the Arkitex Client logon screen, enter your user login name and password 
assigned by the system administrator.

Press the Log In button, and the Arkitex Client dialog screen appears.

Login Errors If a user login name is entered that is already being used in Client, an error 
message will be displayed. If this occurs, press the OK button, and close or log out 
of the Client that is using this user login name.

Version Platform Operating System

IE 5.0 • PC Windows 95, 98, NT, 2000

IE 5.5 • PC Windows 95, 98, NT, 2000

IE 6.0 and 
higher

• PC Windows 95, 98, NT, 2000, 2003

FireFox
2.0

•PC Windows 95, 98, XP, NT, 2000, 
2003

Safari • MAC OS X 10.4
11
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Logout Controls Once successfully logged into Client, the login screen will update to the logout 
screen. A new window, Arkitex Client, will appear in the foreground.

Log out of Client at any time by pressing the Log Out button on the Logout 
screen, or by clicking on File > Logout from the menu bar.

Menu Bar

The menu bar accesses File, Edit, View, Tools, Actions, and Help options.

The table describes the information in the Client Menu.

NOTE: Some items appear disabled if permissions are not granted for use.

Table 2.1 Client Menu Options

Menu Option Description

File

Preferences Opens the Set Preferences dialog box to configure Client 
and Courier functionality. (If Director was also purchased, 
a tab will appear to configure it.)

Logout Logs out of Client.

Edit

Copy Allows one or more layers of this page to be copied to the 
same or another edition. These menu items are disabled 
if multiple tracking icons have been selected. If two 
layers have arrived (e.g., K and C), then this function will 
copy both layers and paste both layers.

Cut Removes the file to be pasted elsewhere, or simply be 
removed.

Paste A dialog box appears allowing selection of the source 
page and destination page. If two layers have arrived 
(e.g., K and C), then this function will copy both layers, 
and paste both layers. If two layers are pasted to a 
tracking icon that has only one layer defined, only the 
appropriate layer is copied.

Select All Causes all of the tracking icons to be highlighted.

View

Tracking Shows transmission status for all files to all destinations 
corresponding to the selected publication tree node.
Arkitex Courier Quick Reference Guide
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Thumbnails Shows thumbnails of files to be transmitted. Each thumb-
nail shows a soft proof of the page; and page number, 
composite and color information through a tooltip.

Details Shows some of the same information as the tracking 
view; however, the Details view shows more focused 
information regarding each layer.

Files Shows color-coded icons indicating the status of files. 
The colors used are configured under Preferences > 
Courier > Colors.

Destinations Displays three-dimensional icons representing each con-
figured site that receives transmission files. The color of 
the site icon determines its status.

Hide Shared Pages Hides shared pages in the edition.

File Status Legend Displays the Files Status Legend as a separate window 
when you are in either Tracking or Files view. The colors 
in the legend are the colors chosen using Preferences > 
Courier > Colors.

Increase Font Size The size of the screen fonts will increase (+) 6 point sizes 
from whatever was set in WebViewLocales.xml (the file 
used to select the font for different languages).

Decrease Font Size The size of the screen fonts will decrease (-) 6 point sizes 
from whatever was set in WebViewLocales.xml (the file 
used to select the font for different languages).

Refresh Refreshes the screen display.

Tools

Configuration... Displays the Configuration dialog box to configure 
Destinations, Destination Groups, Input, Users, System, 
and Renaming Rules. This option is only available with 
system administrator permission.

View Clients... Allows users with configuration permission to disconnect 
other users.

Soft Proof... Displays the Soft Proof of this page (if the edition was 
configured to generate Soft Proofs, and the Soft Proof has 
already been generated). Users without Soft Proof 
permission for the selected edition cannot access this 
option, and the Soft Proof menu items will be disabled.

Soft Proof Printer Pair... Displays the first and last pages of an edition in a soft 
proof screen.

Soft Proof Reader Pair... Displays two consecutive pages of an edition in a soft 
proof screen.

High Resolution Soft Proof... Displays a high resolution soft proof of the file. This 
feature must be enabled for this option to appear.

View PDF... View the source PDF file of the soft proof.
Arkitex Courier Quick Reference Guide
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Status... Shows general information (File Name, Publication Date, 
Edition Name, Page Number), Destinations (Destinations 
and Status), History (Page, Color, File, Timestamp, 
Destination, Message, and User), and Errors (Type, 
DateTime, System, and Summary).

Edition Status... Displays the Edition Status (Edition Name, Files Received, 
Files Transmitted) using progress bars, ratios, numbers 
missing, and text labels.

History... Displays the Edition History (Page, Color, File, Timestamp, 
Destination, Message, User), and System History (File, 
Timestamp, Action, Message, User).

Error Log... Displays an Error Log (Type, DateTime, System, Summary) 
where errors can be acknowledged.

Message Board... Displays a message board with In and Out tabs. Messages 
can also be printed and deleted.

Reset Cache Use to clear the server pages cache. When you click this 
option, no visual indication is returned to the screen; but 
the cache is cleared.

Manual Purge... Opens the Manual Purge dialog box. Publications, 
editions, express files, unplanned files, duplicate files, 
Courier and Director data files, Director Sites, system 
logs, and report data can be purged. You can reset/clear 
the Page Status for Courier and Director data files.

Automatic Purge... Opens the Automatic Purge dialog box. Tasks can be 
scheduled hourly, daily, or weekly. Plans can be purged/
reset; and can include Courier/Director data files, and 
Director sites. System Log; and Report Data older than a 
specified date can deleted. You can also purge files 
based on meeting conditions. You can archive data files 
and backup logs.

Configure Alerts... Opens the Configure Alerts dialog box where system 
events can be selected and an alert action can be chosen 
for that event. Alert configurations can be imported and 
exported.

Actions

Manual Changes... Activates the Manual Change dialog box. This includes 
Inks And File Names, Versions, and Priorities for 
composite/separation files, and double burn files.

Approve Page Enabled if page approval is required for the edition.

Selected Pages Approves all selected pages.

Selected Layers Approves all selected layers.

Approve Advertising Enabled if advertising approval is required for the edition.

Selected Pages Approves all selected pages.

Selected Layers Approves all selected layers.

Approve Editorial Enabled if editorial approval is required for the edition.
Arkitex Courier Quick Reference Guide
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Selected Pages Approves all selected pages.

Selected Layers Approve all selected layers.

Hold Page Enabled if the user has Hold permission for the edition.

Selected Pages Holds selected pages.

Selected Layers Holds selected layers.

Unhold Page Enabled if the user has Unhold permission for the edition.

Selected Pages Unholds selected pages.

Selected Layers Unholds selected layers.

Rename Output... Rename Output allows you to add a prefix or suffix to a 
file or files if a print site system requires them.

Retransmit... Retransmit a file.

Cancel Transmission... Cancels transmission of the file.

Kill Page

Selected Pages Selected pages of an edition can be killed and purged 
from the Courier engine.

Selected Layers Selected layers of a page can be killed and purged from 
the Courier engine.

Selected Versions Selected versions of page can be killed and purged from 
the Courier engine.

Clear Page Clears the selected page(s) or layer(s).

Selected Pages Clears selected pages.

Selected Layers Clears selected layers.

Close Edition If an edition has been opened, it can be closed manually.

Opens Edition If an Edition has been closed, it can be reopened manu-

ally. 

Help

About Describes the build version of Client.

Help Opens a Help dialog box.
Arkitex Courier Quick Reference Guide
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Toolbar

The permissions assigned to the user login will control what is displayed in the 
Client toolbar. The toolbar will be populated with more information and extra 
controls when other permissions are assigned.

Tools available are: Input, Errors, Alerts, Messages, Hot Time, View 
Tracking, View Thumbnails, View Details, View Files, View Destinations, 
and Show.

Input This button is an animated icon showing that Courier is actively scanning input 
folders for new files. To stop scanning or resume scanning, click on the icon.

Errors This button turns red if any error occurs in Courier (such as reading MAXML 
plans, or generating soft proofs), if there is an error in transmitting to any desti-
nation. Clicking the button displays an Error Log. Once all errors are 
acknowledged, the button will be restored to green.

Alerts This button turns yellow if any alert occurs. Clicking the button displays an 
Alerts Log. Once all alerts are acknowledged, the button will be restored to 
green.

Messages Displays a message board with In and Out tabs. Messages can also be printed and 
deleted.

Hot Time This button appears gray when no Hot Time is set. It appears as a blue clock 
when a Hot Time has been set. During Hot Time, the icon appears as a flame and 
after the Hot Time, the icon appears as a red clock.

Multiple Hot Times The Hot Time button now has a multiple state if a destination is selected that has 
a different hot time than other destinations receiving the same publication. The 
Hot Time button will appear as multiple buttons (blue clock, flame, red clock) 
on the toolbar.

Tracking This button shows the status of transmissions to all destinations for all files 
corresponding to the selected publication tree node, including collapsible bars 
separating Editions, Sections, etc.
Arkitex Courier Quick Reference Guide
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Thumbnails This button shows thumbnails of files to be transmitted. Each thumbnail shows 
a soft proof of the page; and page number, composite and color information 
through a tooltip.

If enabled in Preferences > Courier > Display > Page Icon Options, check 
boxes for approvals, the version number, and CMYK colors will display in the 
thumbnail.

Details This button shows some of the same information as Tracking; however, Details 
shows more focused information regarding each layer specific to a destination.

Files This button shows color-coded icons indicating the status of files. The colors 
used are configured under Preferences > Courier > Display.

View Destinations This button shows three-dimensional icons representing each configured site 
that receives transmission files. The color of the site icon determines its status.

Show The Show drop down is used to filter the Tracking, Thumbnails, Details, and File 
displays. It is not active in Destinations View.

■ All - Shows all pages without filtering.

■ Not Arrived - Indicates which pages have not arrived yet.

■ Awaiting Approval - Shows pages waiting for approval.

■ Arrived And Awaiting Approval - Shows pages that arrived and need 
approval.

■ Held - Shows pages that are on hold.

■ Awaiting Transmission - Shows pages waiting for transmission.

■ Transmitting - Shows pages that are transmitting.

■ Not Complete - Shows pages that are incomplete.
Arkitex Courier Quick Reference Guide
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Server Pull-down Bar

At the top of the Publication Tree is the Server Pull-down bar, which allows 
selection of either Courier server(s), or one or more Director servers to monitor. 
The names of the Courier and Director servers are configurable and will appear 
in the order of configuration. Permissions will determine which servers and 
editions appear in the server button and navigation tree.

NOTE: Only a user with administrative permissions can configure Courier or 
Director servers.

Plans

The Plans node is used to track the basic status of plans to destinations. The 
Plans icon will always appear whether or not there are plans in the system. Only 
the Tracking Table, Details, and Files views will be available when the Plans 
node is selected.

Navigation Tree Hide/Unhide

You can hide the Publication Tree, Courier Express Pane, and the Unprocessed 
Files Pane by using the left/right arrows next to the Publication Tree, right above 
Courier Express, and right above the Unprocessed Files Pane.

You can also drag the separation bars to adjust the display.

Publication Tree

The Publication Tree is a flexible, user-defined hierarchy of press run time, 
publication day, publication name, edition name, zone name, and sections. The 
Publication Tree will display in different colors depending on the status of an 
edition. A status can include being on hold, having deferred approval, having a 
hot time assigned, etc.

Awaiting Approval
Indicator

If a page is awaiting approval, this is indicated by an exclamation mark in the 
Edition tree. When the page is approved, the mark disappears. The indicator can 
Arkitex Courier Quick Reference Guide
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be enabled or disabled. Refer to “Show Indicator If Any Page Is Awaiting 
Approval” on page 23.

Courier Express

Below the edition nodes are express in/out point nodes (Courier Express). The 
status of files not associated with editions, but that get their configuration from 
the input point, can be monitored.

By selecting an input point, files can be tracked in each of the five Main Pane 
views exactly as an edition node in the tree had been selected.

NOTE: The selection of an express node causes the Publication Tree node to be 
deselected, and vice versa.

Dynamic Updates The Courier Express and the Main Pane will dynamically update as input points 
are:

■ Added or deleted.

■ New files arrive at the input points.

■ The input points are purged.

If you double-click on an express file, the status dialog box appears. If you right 
click, the shortcut menu appears.

Unprocessed Files Pane

The view is dynamically updated as new unplanned or duplicate files arrive, or 
are removed from either the Unplanned or Duplicates tabs.

Main Pane

The Main Pane shows page thumbnails, status of transmissions to all 
destinations, selected destinations, or a summary of destination status for the 
selected tree node depending on the view button selected in the toolbar.
Arkitex Courier Quick Reference Guide



20 EXPAND/COLLAPSE

CG+0952650001.book  Page 20  Monday, January 8, 2007  6:50 PM
Expand/Collapse

Expand and collapse triangles are available for the Publication Tree, Express 
Tree, and the Unplanned panes.

■ Publication Tree

Clicking the right triangle expands the pane. Clicking the left triangle collapses 
the pane.

■ Express and Unplanned

Clicking the upward triangle expands the pane. Clicking the downward triangle 
collapses the pane.

You can also drag the dividing bars to the desired position to size the panes.

Status Bar

Located on the bottom of the Client window, the Status Bar reports the time and 
date of the last automatic refresh of Arkitex Client. When a user logs in with 
permission to access an edition, the Status Bar additionally displays information 
related to the selected edition, e.g., Edition Name and Hot Time details (where 
relevant).
Arkitex Courier Quick Reference Guide
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3 Preferences

Customizable features of Courier and Client are reviewed in this chapter.

Preferences for Client

When logged into Client, the system will automatically check for a Client 
configuration assigned to your User Login name. If it does not find a 
configuration, it will use the default configuration.

To change the display of the Client Dialog, go to File > Preferences from the 
menu bar.

The Set Preferences dialog box will appear with two tab options under the 
Client tab:

■ General

■ Publication Tree

■ Display

General Tab The General tab supplies the following configurations:

■ Locale

■ Refresh Time (seconds)

■ Soft Proof Options

■ Enable ICC Profiles

■ Text Message Options

■ Change Password
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Locale

Use this option to assign a language other than “English (United States)” to be 
used within Client.

The Set Preferences dialog box drop down list box displays the standard 
languages provided with a standard Client installation.

Refresh Time (seconds)

The Refresh Time can be set from 5 to 995 seconds.

Soft Proof Options

■ Show Separations In Soft Proof - Displays layer separations in the soft 
proof.

■ Fit Soft Proof To Window - Fits the soft proof to the window size.

■ Allow Exporting of Soft Proofs Images - Enables soft proof image 
exporting.

Default folder to store exported images - The folder that holds exported 
images.

Enable ICC Profiles

The Client Soft Proof display can now be improved to allow you to preview your 
Soft Proofs using Image Color Calibration (I.C.C.) profiles to more closely match 
the Soft Proofs to the final output. The I.C.C. profiles convert the incoming data 
to make the soft proofs more closely represent the final printed product. By 
default, Enable ICC Profiles is disabled.

■ Input CMYK ICC Profile - Opens a dialog box to browse to the desired profile 
that calibrates to the printer.

■ Monitor RGB ICC Profile - Opens a dialog box to browse to the desired 
profile that matches your monitor.

Text Message Options

■ Play Sound Alert When Unread Messages Exist - When checked a sound 
file will play when there are unread messages in the Message Board.
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Sound File - The name of the sound file. You can browse to the sound file 
location.

Loop Sound File - When checked the sound file will loop.

Keep Playing Until All Messages Have Been Read - When checked the 
sound file will continue to play until all messages in the Message Board 
have been read.

Change Password

When pressed the Change Password dialog box opens to enter a new password.

Publication Tree
Tab

Use this tab to expand the tree for new editions, to sort editions, and to change 
the display of the Tree Hierarchy. Options include:

■ Expand Tree For New Editions

■ Show Indicator If Any Page Is Awaiting Approval

■ Tree Hierarchy

■ Tree Preview

Expand Tree For New Editions

This option expands the tree to display new editions when they arrive.

Show Indicator If Any Page Is Awaiting Approval

An indicator will display in the Publication Tree showing pages need approval.

Tree Hierarchy

The Tree Hierarchy controls what information will display in the tree, and in 
what sort order. The Tree levels available are:

■ Press Run Time - Time and date of the press run(s).

■ Publication Day - Day of the week and date of the publication(s).

■ Publication Name - Name given to the publication(s).

■ Edition Name - Name given to the edition(s).
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■ Zone Name - Name given to the zone(s).

■ Section Name - Name given to the section(s).

■ View Group Name - Name given to the group(s) defined in the publication 
plan.

Contents/Variations

In the Tree Hierarchy dialog, when the Contents box is checked, pages based on 
content approval (advertising, editorial, classified) can be viewed at each given 
level.

When the Variations box is checked, page variations (planned changes) can be 
viewed at the given level.

Tree Preview

The preview is determined by what is selected in the Tree Hierarchy. Use the 
Move Up or Move Down buttons, when available, to select the tree view order.

This dialog box previews the tree display as configured.

Display Tab Use this tab to control File Versions, Toolbar Buttons, and Background Color. 
Options include:

File Versions

■ Show All Versions - Displays all versions of the file.

■ Show Current Version Only - Displays only the current file version.

Toolbar Buttons

■ Icons Only - Displays icons only in the toolbar.

■ Icons and Text Labels - Displays icons and text labels in the Client toolbar.

Background Color

■ Light - Set the background color to light.

■ Medium - Set the background color to medium.
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■ Dark - Set the background color to dark

Preferences for Courier

The Set Preferences dialog box has two tab options under the Courier tab:

■ General

■ Page Icon

■ Display

■ Colors

General Tab Use the General Tab to set prompting messages when certain options are used.

Ask Are You Sure For

The Ask Are You Sure For is used to configure after which Change command an 
“Are you sure” warning prompt will be displayed (this is only relevant with 
Change permission).

If the check box next to each of the following options is enabled (checked), a 
warning message will appear.

■ Hold Page - Asks before holding the selected page.

■ Unhold Page - Asks before unholding the selected page.

■ Hold Edition - Asks before holding the selected edition.

■ Unhold Edition - Asks before unholding the selected edition.

■ Kill Page - Asks before killing the selected page.

■ Paste - Asks before pasting to an edition.

■ Delete - Asks before deleting a file in the Unplanned Folder.

NOTE: Pressing the All button will check all the boxes. Pressing the None button 
will uncheck the boxes.
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Sort Editions

This option controls the order in which the editions are displayed within the 
Arkitex Client Publication Tree.

Page Icon Options

Page Icon Options are used to add to the thumbnail display: a checkbox for 
Approval, Display Versions, and Display Expected Color in Thumbnails. All three 
options can be used at the same time.

Display Tab The Display tab controls the Tracking View ID and Page Icon Options.

Tracking View ID

The Tracking View ID is used to label the first column in the Tracking and Details 
Views. Only one option can be active at a time:

By Plan Order Sorts editions by the order they were 
defined in Publication Builder.

Alphabetically Sorts editions alphabetically from A-Z.

Display Approval Displays approval check boxes in the 
thumbnail icon.

Display Versions Displays the version number in the 
thumbnail icon.

Display Expected Colors In 
Thumbnails

Displays expected colors in the 
thumbnail icon.

Page Number Defines the tracking view ID as the page 
number.

Page Name Defines the tracking view ID as the page 
name.

File Name Defines the tracking view ID as the file 
name.
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Tracking View Columns

Details View Columns

Output Name Defines the tracking view ID as the 
output name.

Version Displays a version column.

Pre Transmission Script 
Status

Displays a script status column.

Page Approval Displays a page approval column.

Advertising Approval Displays an advertising approval 
column.

Editorial Approval Displays an editorial approval 
column.

Color (03) Displays a column for the color 
part of a page.

Black (01) Displays a column for the black 
part of a page.

All (04) Displays a column for all colors.

Version Displays a version column.

Received Displays a received column.

Arrival Time Displays an arrival time column.

Pre Transmission Script 
Status

Displays a script status column.

Page Approval Displays a page approval column.

Advertising Approval Displays an advertising approval 
column.

Editorial Approval Displays an editorial approval 
column.

Color (03) Displays a column for the color 
part of a page.
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Colors Tab Use the Colors Tab to change colors of file types in Files View to show their 
status. The following options are available:

Tracking View Colors

Colors displayed in Tracking View, Details View, and Files View can be 
customized.

Table 3.1 Default Colors on a Clean System

Black (01) Displays a column for the black 
part of a page.

All (04) Displays a column for all colors.

TR Start Displays a transmission start 
column.

TR End Displays a transmission end 
column.

TR Elapsed Displays a transmission elapsed 
column.

TR Retries Displays a transmission retries 
column.

Hot Time Displays a hot time column.

Priority Displays a priority column.

Size Displays a size column.

Status Displays a status column.

Not Expected Used to change the color of not 
expected files.

Expected Used to change the color of 
expected files.

Waiting to Transmit Used to change the color of files 
waiting to transmit. 

Transmitting Used to change the color of 
transmitting files. 

Transmission 
Complete

Used to change the color of files 
where transmission is complete.
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Choose Color Buttons

When a Choose Color button is pressed, a dialog box opens displaying 
Swatches, HSB, and RGB options, along with color pallet and preview.

Swatches

These are color patches. Click on a color to place it in the Recent color table.

HSB

HSB stands for Hue, Saturation, Brightness (a color model). You can enter RGB 
values or use the slider to select the color.

Transmission Canceled Used to change the color of files 
where transmission was 
canceled. 

Error Used to change the color of 
errored files. 

Hold Used to change the color of files 
on hold. 

Obsolete Files 
Background

Used to change the background 
color of Obsolete files. 

Obsolete Files Text Used to change the text color of 
Obsolete files. 

Killed Files 
Background

Used to change the background 
color of killed files. 

Killed Files Text Used to change the text color of 
killed files. 

Imaging Started The defined imaging event has 
started.

Imaging Completed The defined imaging event has 
completed.

Imaging Error There was an error in the imaging 
event.

Director Complete The defined completion event 
defined has occurred.
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RGB

RGB stands for Red-Green-Blue (a color model based on additive color prima-
ries). You can enter RGB values or use the slider to select the color.

Recent

Colors from the palette in their order of selection are displayed. By clicking on a 
color in the Recent palette, this will become the Preview color.

Preview

The Preview changes as different colors are selected.

Restore Original Colors

Colors can be restored to the system defaults.

Save Settings If any of the configuration settings are changed, the new configuration will be 
saved when the OK button is pressed, closing the Set Preferences dialog box.

NOTE: This new configuration will be assigned to the user login name, and each 
time a logon occurs, this personal configuration will be used.
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4 Configuration

This chapter briefly describes configuration of the Courier Server.

Configuration

All system configuration is permission-based and is accomplished though the 
browser-based Client application. Configuration can take place on a running 
system, and any changes made do not require restarting the server, or any server 
subsystems, for changes to take effect.

Configure Server Using the Tools > Configuration server menu, a Courier server can be selected 
for configuration. Full configuration data can be imported or exported in an XML 
format for backup, transfers, configurations, and support purposes.

If a new configuration is received, the Courier engine will update its database 
and perform any changes and/or additional transmissions required. This update 
is dynamic.

NOTE: Only with administrator permission will the Tools > Configuration 
option be available.

Related topics: For additional information on Configuration, refer to the Courier System 
Administration Guide, or the Online help.
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5 Views

This chapter describes the Tracking, Thumbnails, Details, Files, Destinations, 
Queue View, Plans, Courier Express, and Unplanned Files Pane views.

Tracking

The status of transmissions to all destinations is displayed for all files 
corresponding to the selected publication tree node.

Group Tabs A tab will appear for every group configured to receive transmitted files. Select a 
tab to see files just for that group. A tab called All shows all groups.

Column Headings The column headings are: Page Number, File Name or Page Name; Version; 
Script Status; Advertising Approval; Editorial Approval; and Destination 
columns for configured sites.

NOTE: The first column could show Page Number, File Name, or Page Name if 
one was chosen under “Tracking View ID” on page 26. Only one can be turned on 
at a time.

Layer Colors If a page is a composite, a small box with four colors will display. If a page is a 
separation layer, it will display a small box in that layer’s color (cyan, magenta, 
black, or yellow).

Ignored Pages If a page is ignored, a small, red circle with a diagonal line will appear before the 
layer color.

Tracking View
Colors

The Group columns could display in color if the file is in a specific state (i.e., on 
hold, or in error). The colors used are configured under “Colors Tab” on page 28.
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Late Black Late Black allows the early release of color elements and late release of black 
elements of composite pages, and has instructions sent to Director print sites. If 
a plan arrives with late black, columns will display for Color (03), Black (01), 
and All Colors (04).

Deferred Approval Deferred Approval allows pages requiring approval to be sent to the print site 
as soon as possible while allowing a later approval message to release the page 
for imaging. The user interface displays by using blue in both the tree and in the 
approval columns.

Sorting Information in the first column can be sorted by clicking the column heading.

Clicking once sorts in descending order, clicking a second time sorts in 
ascending order. Clicking a third time sorts by printer pair. You can also click the 
column heading while holding the Ctrl key to sort by printer pair.

Navigating Clicking the left or right, up or down arrows on the keyboard moves the cursor 
through the cells in the table.

Status Dialog Box Double-clicking on a file displays the Status dialog box, which displays the 
following:

■ General - File Name, Page, Edition, Publication Date, and Output Name

■ Destinations - Destination and Transmission Status

■ History tab - Page, Color, File, Timestamp, Destination, Message, and User

■ Errors tab - Type, DateTime, System, and Summary

Errors If the site is on hold, the column heading and Destination tab will turn yellow. 
If the site has an error, the column heading and Destination tab will turn red. If 
the site is functioning correctly, the column heading will be green.

Maximum Items The maximum number of line items that will display. There is no limit to the 
number of items that can be displayed.

■ Refresh - Clicking this button refreshes the display.
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Thumbnails

Thumbnails displays a miniature black and white or color soft proof of the page 
(if available), and page number.

If a page is expected in color, vertical color bars will appear to the left of the 
softproof in the thumbnail.

If a page is expected in black and white, vertical black and gray bars will appear 
to the left of the softproof.

If a page is ignored, the thumbnail will display with a large red X.

Group Tabs A tab will appear for every group configured to receive transmitted files. Select 
a tab to see files just for that group. A tab called All shows all groups.

Optional Display The following items may also be displayed on the thumbnail if enabled in 
“Colors Tab” on page 28:

■ Display Approval (these display as check boxes).

■ Display Versions (this displays as a V).

■ Display Expected colors In Thumbnails (these display as colored vertical 
bars).

■ Late Black (These display as check boxes for Color (03), Black (01), and All 
Colors (04).

Tooltip Display The following items are displayed by resting the mouse pointer on a thumbnail:

■ Page

■ Composite

■ Separation Layer(s)

Soft Proof Window Double-clicking on a thumbnail displays the Soft Proof window.
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NOTE: If layers are approved, the Composite and Separations views will display 
with approval checkboxes. These are visual markers only. If a layer has not yet 
been approved, the layer will display in a solid color.

Details

Some of the same information as Tracking is displayed; however, Details shows 
more focused information regarding each layer specific to a destination.

Destination Tabs A tab will appear for every destination configured to receive transmitted files. 
Select a tab to see files just for that destination.

Errors If the site is on hold, the Destination tab will turn yellow. If the site has an error, 
the Destination tab will turn red.

Column Headings The column headings are: Page Number, File Name or Page Name; Version; 
Received; Arrival Time; Pre Transmission Script Status; Advertising 
Approval; Editorial Approval; TR Start; TR End; TR Elapsed; TR Retries; Hot 
Time; Priority; Size; and Status.

NOTE: The first column could show Page Number, File Name, or Page Name if 
one was chosen under “Tracking View ID” on page 26. Only one can be turned 
on at a time.

Layer Colors If a page is a composite, a small box with four colors will display. If a page is a 
separation layer, it will display a small box in that layer’s color (cyan, magenta, 
black, or yellow).

Ignored Pages If a page is ignored, a small, red circle with a diagonal line will appear before the 
layer color.

Tracking View
Colors

The Group columns could display in color if the file is in a specific state (i.e., on 
hold, or in error). The colors used are configured under “Colors Tab” on page 28.
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Late Black If a plan arrives with late black, columns will display for Color (03), Black (01), 
and All Colors (04).

Deferred Approval The user interface displays by using blue in the approval columns.

Navigating Clicking the left or right, up or down arrows on the keyboard moves the cursor 
through the cells in the table.

Sorting Information in the first column can be sorted by clicking the column heading.

Clicking once sorts in descending order, clicking a second time sorts in 
ascending order. Clicking a third time sorts by printer pair. You can also click the 
column heading while holding the Ctrl key to sort by printer pair.

Status Dialog Box Double-clicking on a file displays the Status dialog box (see “Status Dialog Box” 
on page 34).

Files

Files shows color-coded icons indicating file status. The colors used are 
configured under “Colors Tab” on page 28.

If a file is ignored, a small, red circle will appear in the file icon.

Status Dialog Box Double-clicking on a file displays the Status dialog box (see “Status Dialog Box” 
on page 34).

Destinations

Destinations displays three-dimensional icons representing each configured 
site that receives transmission files. The color of the site icon determines its 
status:

■ Idle (Gray) - The site is present and accessible, but no files are being sent.

■ Transmission in Progress (Animated) - The icon animates to indicate files 
are currently being sent to the site.
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■ Hold (Yellow) - All transmission to the site is on hold.

■ Error (Red) - There is an error at the site.

Queue View Queue View allows monitoring of files transmitted to receiving sites. By clicking 
on a Destination tab, the view for that site is displayed.

Column Headings

The column headings are: File Expected Color; Page Number, Page Number, 
File Name; Version; Received; TR Start; TR End; Hot Time; Priority; and 
Size.

NOTE: The first column could show File Name or Page Name if one or the other 
was chosen under “Tracking View ID” on page 26. Only one can be turned on at 
a time.

Navigating

Clicking the left or right, up or down arrows on the keyboard moves the cursor 
through the cells in the table.

Sorting

Information in the first column can be sorted by clicking the first column 
heading.

Clicking once sorts in descending order, clicking a second time sorts in 
ascending order. Clicking a third time sorts by printer pair. You can also click the 
column heading while holding the Ctrl key to sort by printer pair.

Errors

If the site is on hold, the Destination tab will turn yellow. If the site has an error, 
the Destination tab will turn red.

Float/Dock Queue View

Queue View is docked underneath the site icons. The view can be floated by 
clicking the Float Queue View button at the bottom right corner of the screen. 
Click the Dock Queue View button to dock the display.
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Plans

The Plans node is used to track the basic status of plans to destinations. The 
Plans icon will always appear whether or not there are plans in the system. Only 
the Tracking, Details, and Files views will be available when the Plans node is 
selected.

Tracking The All tab is located at the beginning of the view and displays all groups. 
Individual group tabs will also display and are used for filtering plans for that 
group.

Column Headings

■ Page Number, File Name, or Page Name shows all pages in the plan.

■ Version shows the version of the plan.

■ Script Status shows the status of scripts if they are run. An icon resembling a 
scroll in different colors represents the run status:

Expected (white).

Successful (green).

Failure (red).

Canceled (red with a cross).

■ Destination Columns show the configured destinations that will receive the 
plan.

Details Destination tabs are located at the beginning of the view and display transmis-
sion destinations.

Column Headings

■ Page Number, File Name, or Page Name shows all pages in the plan.

■ Version shows the version of the plan.

■ Received shows that the plan was received.
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■ Arrival Time shows the time the file arrived.

■ Pre Transmission Script Status shows the status of scripts if they are run. 
An icon resembling a scroll in different colors represents the run status:

Expected (white).

Successful (green).

Failure (red).

Canceled (red with a cross).

■ TR Start shows the time transmission started.

■ TR End shows the time transmission ended.

■ TR Elapsed shows the time elapsed in transmission.

■ TR Retries shows the number of transmission retried.

■ Hot Time shows the hot time if set.

■ Priority shows the file’s priority.

■ Size shows the file size.

Files Only color-coded icons and file names display.

Errors If the site is on hold, the column heading will turn yellow. If the site has an error, 
the column heading will turn red. If the site is functioning correctly, the column 
heading will be green.

Navigating Clicking the left or right, up or down arrows on the keyboard moves the cursor 
through the cells in the table.

Sorting Information in the first column can be sorted by clicking the column heading. 
Sorting is either in descending or ascending order.
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Courier Express

The Main Pane will display different information depending on the view chosen.

Tracking The Main Pane displays columns: Group Tabs; Page Name, File Name, or Page 
Number; Version; Script Status; Transmitted; and Destination columns for 
configured sites.

Thumbnails The Main Pane displays with group tabs and thumbnails.

NOTE: The thumbnails could also show Display Approval, Display Version, and 
Display Expected Colors in Thumbnails if one or more were chosen under 
“Colors Tab” on page 28.

Details The Main Pane displays columns: Page Name, File Name, or Page Number; 
Version; Received; Arrival Time; Pre Transmission Script Status; TR Start; 
TR End; TR Elapsed; TR Retries; Hot Time; Priority; and Size.

Files The Main Pane displays file names.

Destinations Destinations displays three-dimensional icons representing each configured 
site that receives transmission files.

Queue View

Queue View column headings are: File Expected Color; Page Number, Page 
Number, File Name; Version; Received; TR Start; TR End; Hot Time; 
Priority; and Size.

NOTE: The first column could show File Name or Page Name if one or the other 
was chosen under “Tracking View ID” on page 26. Only one can be turned on at 
a time.
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Unprocessed Files Pane

Unprocessed files consist of unplanned files and duplicate files. The Unproc-
essed Files pane contains two tabs: Unplanned and Duplicates.

Filtering A filtering and sorting toolbar appears at the top of the Unprocessed Files 
window.

■ Filter - A text box for entry of a filter string. The string can contain alpha-
numeric characters along with * (any characters), or ? (any single character).

■ Apply Filter - Places Unplanned or Duplicates into filtered mode. In filtered 
mode the button turns purple. Found files will display with a purple outline.

■ First In - Sorts by first files in. This is the default value.

■ Last In - Sorts by last files in.

■ Alpha Ascending - When in List view, files are sorted vertically first.

■ Alpha Descending - When in List view, files are sorted vertically first.

■ List View - Displays a list of files. This is the default view.

■ Thumbnail View - Displays thumbnails of files.

■ Float Unplanned - Float Unplanned or Duplicates. The Unprocessed Files 
pane by default is docked. It can also float as a separate window in the Main 
Pane.

Unplanned and
Duplicates

The view is dynamically updated as new unplanned or duplicate files arrive, or 
are removed from the Unplanned tab.

If Soft Proofs are available, a soft proof icon will appear before the file name. 
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6 Shortcut Menus

The following chapter describes shortcut menus. Shortcut menus are available 
for Plans, Publication Tree, Courier Express, Main Pane, Destinations, and 
Unprocessed Files Pane.

Plans

After the Plans node on the Publication Tree is selected, right-click on a plan in 
the main pane to display the shortcut menu. The options are Retransmit and 
Cancel Transmission.

Retransmit Allows the retransmission of the selected plan. Right-clicking the plan name 
displays the Retransmit dialog box.

■ Plan Name identifies the name of the plan.

■ Select Plan is a check box that selects that plan to retransmit. 

■ Select All Destinations - Selects all available destinations to receive 
retransmission.

■ Destination Check Boxes - Individual destinations can be selected to receive 
the retransmission.

NOTE: Right-clicking on the Plans node in the Publication Tree does not display 
a shortcut menu.

Cancel
Transmission

Cancels transmission of a plan to print sites.

Publication Tree

Depending on permission levels, right-clicking on a node in the Publication 
Tree displays a shortcut menu with these options: Approve Pages, Approve 
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Advertising, Approve Editorial, Hold, Unhold, Skip Approval, Un-Skip 
Approval, Close Edition, and Open Edition.

Approve Pages With permission, all pages for the selected node can be approved by page or 
layer:

■ If selected, approves page for the selected pages 

■ If selected, approves page for selected layers.

Approve
Advertising

With permission, all advertising for the selected edition can be approved by page 
or layer:

■ If selected, approves advertising for the selected pages 

■ If selected, approves advertising for selected layers.

Approve Editorial With permission, all editorials for the selected edition can be approved by page 
or layer:

■ If selected, approves editorials for the selected pages 

■ If selected, approves editorials for selected layers.

Hold Selected page(s) or layer(s) in an edition can be held. When clicked, the Unhold 
All pages dialog box is displayed with the following options:

■ Selected Pages - All layers of the page are held even though only a single 
layer is selected.

■ Selected Layers - Certain layers of the page are held.

Unhold Previously held page or layer can be released. Scanning for input in a particular 
folder is stopped, turning off the value of input until released. When clicked, the 
Unhold All pages dialog box is displayed with the following options:

■ Selected Pages - All layers of the page are unheld even though only a single 
layer is selected.

■ Selected Layers - Selected layers are unheld.
Arkitex Courier Quick Reference Guide



 

6 SHORTCUT MENUS 45

CG+0952650001.book  Page 45  Monday, January 8, 2007  6:50 PM
Skip Approval With permission, the normal workflow approval process can be overridden to 
meet a deadline or expedite the output of a publication. Unlike approval, it can 
take place at any time, not just when an object is ready for approval. It takes 
effect on any objects not already past the approval process.

Un-Skip Approval With permission, skipping approval for the selected edition can be reversed. It 
takes effect on any objects not already past the approval process.

Close Edition Editions may be closed to indicate that all expected files have been received. 
Closing can be done at the Edition and Zone levels only, and can be done 
manually or automatically. 

■  Manual closing is done by right-clicking the Publication Tree node, and 
selecting Close Edition.

■ Editions will close automatically when all files specified in the plan have been 
received. The Publication Tree node icon changes to indicate a closed state. 
Closing an edition also triggers a report.

■ The actual close time--whether the edition closes automatically or 
manually--is when the last file arrived for the first time (automatic close), or 
when the last file arrived (manual close).

■ Closing an edition is only used for reporting and the client display. It will have 
no impact on other system functionality.

Open Edition If an Edition has been closed, it can be reopened manually. The Publication Tree 
node icon changes to indicate an open state.

Courier Express

After the Courier Express folder on the Publication Tree is selected, right-click 
on a file in the Main Pane to display the shortcut menu. Depending on permis-
sion levels, options available are: Soft Proof, Soft Proof Printer Pair, Soft 
Proof Reader Pair, High Resolution Soft Proof, View PDF, Status, Manual 
Changes, Approve, Approve Advertising, Approve Editorial, Hold, Unhold, 
Rename Output, Retransmit, Cancel Transmission, Kill Page, Clear Page, 
Copy, Cut, Paste, and Select All.
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Soft Proof The Soft Proof window opens, and displays a soft proof of the selected file. If the 
soft proof file is a JPEG, a soft proof window will be displayed. If the file is a PDF, 
a new browser window will be opened. In either case, you can open as many as 
two soft proof windows, and then the windows will be reused. Different tools let 
you zoom in on parts of the image and move the image in the direction of the 
mouse. You can also open a high resolution softproof.

Soft Proof Printer
Pair

Displays the top and bottom pages of the edition in the Soft Proof window.

NOTE: The menu buttons are identical to Soft Proof.

Soft Proof Reader
Pair

Displays two consecutive pages of an edition side by side in the Soft Proof 
window.

NOTE: The menu buttons are identical to Soft Proof.

High Resolution
Soft Proof

Selecting this option opens a High Resolution soft proof. This feature is used to 
review a single TIFF layer to ensure there are no random marks. The High 
Resolution window allows you to:

■ Zoom in and out.

■ Indicate the current cursor position in X/Y pixel coordinates.

■ Invert the image from negative to positive, and vice-versa.

■ View high resolution data for individual layers.

■ Rotate the image.

View PDF The source input PDF file is displayed.

Status Shows all layers for the page selected, if you select Tools > Status from the 
menu bar. If you right-click on a page in the detail panel, and select Status, then 
the Status dialog box is displayed with detailed information.

Manual Changes The Priority of a file can be changed.
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Approve With permission, selected pages can be approved by page or layer.

Approve
Advertising

All advertising in a publication can be approved at the page or layer levels.

Approve Editorial All editorials in a publication can be approved at the page or layer levels.

Hold Selected page(s) or layer(s) in an edition can be held. When clicked, the Unhold 
All pages dialog box is displayed.

Unhold Previously held page or layer can be released. Scanning for input in a particular 
folder is stopped, turning off the value of input until released. When clicked, the 
Unhold All pages dialog box is displayed.

Rename Output This option allows you to add a prefix or suffix to a file or files if a print site 
system requires them.

Retransmit Selected page(s) or layer(s) can be retransmitted. Pages, colors and destinations 
can be selected:

■ Select All Pages and Colors - Checking this box selects all pages and colors.

■ Page - Shows the page number of the selected page.

■ All Colors - All colors for the page are selected.

■ Color Check Boxes - Individual colors can be selected. Colors are CMYK.

■ Select All Destinations - Selects all available destinations to receive 
retransmission.

■ Destination Check Boxes - Individual destinations can be selected to receive 
the retransmission.

Cancel
Transmission

Cancels transmission of a plan to print sites.
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Kill Page Cancels any transmission of a file and removes it from the Courier system. Pages, 
layers, or versions can be killed.

Clear Page Clears the selected page(s) or layer(s).

Copy A copy is made of the selected file.

Cut An individual file is deleted.

NOTE: Press F5 to refresh screen after deletion.

Paste A copy of the selected file is pasted into a new location.

Select All Depending on the view, all files in the main pane can be selected.

■ To select consecutive File Names, click the first item, press and hold down 
Shift key, and then click the last item.

■ To select File Names that are not consecutive, press and hold the Ctrl key, 
and then click on each item.

■ To select all files, right-click on a File Name, and then click Select All.

NOTE: Right-clicking on the Courier Express folder in the Publication Tree 
displays another shortcut menu with only the option: Approve.

Main Pane

Right-clicking on a file in the Main Pane displays the shortcut menu. The 
shortcut menu is identical whether in Tracking, Thumbnails, Details, and Files 
views.

Depending on permission levels, options available are: Soft Proof, Soft Proof 
Printer Pair, Soft Proof Reader Pair, High Resolution Soft Proof, View PDF, 
Status, Manual Changes, Approve, Approve Advertising, Approve Editorial, 
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Hold, Unhold, Rename Output, Retransmit, Cancel Transmission, Kill Page, 
Clear Page, Copy, Cut, Paste, and Select All.

Soft Proof A detailed soft proof displays by double-clicking on one of the thumbnails, or by 
right-clicking on the thumbnail, and selecting Soft Proof. If the Soft Proof 
options are grayed out, a soft proof was not generated for the file.

You can use the hand tool to grab the image and shift it in the direction the 
mouse is moved. You can also open a High Resolution soft proof from within the 
soft proof.

Soft Proof Printer
Pair

Displays the top and bottom pages of the edition in the Soft Proof window.

NOTE: The menu buttons are identical to Soft Proof.

Soft Proof Reader
Pair

Displays two consecutive pages of an edition side by side in the Soft Proof 
window.

NOTE: The menu buttons are identical to Soft Proof.

High Resolution
Soft Proof

Selecting this option opens a High Resolution soft proof. This feature is used to 
review a single TIFF layer to ensure there are no random marks. The High 
Resolution window allows you to:

■ Zoom in and out.

■ Indicate the current cursor position in X/Y pixel coordinates.

■ Invert the image from negative to positive, and vice-versa.

■ View high resolution data for individual layers.

View PDF Displays the source input PDF file, if the file is in a PDF format. An Acrobat reader 
window will be opened to view the file.

Status Status displays detailed information including publication information, status 
at destinations, file history, and any errors. Status can be displayed either by 
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selecting Tools > Status in the menu bar, or right-clicking on a page in the main 
pane, and selecting Status.

Several information tabs are available: General, Destinations, History, and 
Errors.

General Tab

The General Tab displays information on the File Name, Publication Date, 
Edition, and the Page Number.

Destinations Tab

The first column shows a file icon. The Destination column shows the site name 
that received the file. The Status column displays the status of the file 
transmission.

History Tab

The Page column shows the number of the page and an icon. Color shows the 
expected color (CMYK, or [-] for composite) for the page. File displays the file 
name. Timestamp indicates when the event occurred. Destination shows the 
site that received the file. Message shows the status of the action on the file (soft 
proof, approval, transmission). User is the user who initiated the action.

Errors Tab

The Error tab displays types of errors (warning--yellow triangle, or alert--red 
circle with an X), DateTime the error occurred, what System received the error, 
and a Summary description of the error.

Manual Changes The Manual Changes dialog box allows changes to be made to a page on-the-fly. 
Menu options include: Inks and File Names, Versions, Priority, and Deadline.

Inks And File Names

The names of the output files corresponding to each separation are shown, as 
well as the composite file.

■ Composite Input File Name - If the renamed page is expected in separated 
form, enter the names for each expected file.

■ Inks - Black, Cyan, Magenta, and Yellow are listed for each color.
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Input File Name is used to identify the name of each incoming file and to 
link that file to the relevant page’s separation.

■ Double Burn Input File Names - Is used to identify the name of each 
incoming double burn file and can link that file to the relevant page’s 
separation.

■ Replace - Name of file to replace.

■ With - Replacement file name.

■ Update All - Updates all items.

Versions

This includes the composite version and layer versions:

■ Composite File Version - The version of the composite are listed in a drop 
down box. If more than one file version exists, it displays in the list.

■ Inks - Black, Cyan, Magenta, and Yellow are listed in drop down boxes. If 
more than one file version exists, it displays in the list.

■ File Versions - Versions of the selected file along with the date and time are 
displayed.

■ Double Burn File Versions - Versions of the double burn file.

Priority

The priority of each layer can be viewed and changed individually or at once.

■ Composite File Priority - This is the composite priority.

■ Inks - Black, Cyan, Magenta, and Yellow are listed in drop down boxes.

■ Priorities - A slider is available for all color separations that can be moved 
from 2 to 127. Or a value can be typed into the input box.

■ Double Burn File Priority - A slider is available for all double burn file 
separations that can be moved from 2 to 127. Or a value can be typed into 
the input box.

■ Replace - Apriority value can be entered to modify the value at once. 
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■ With - A value can be entered to replace the value at once.

■ Update All - Call modified items are updated at the same time.

NOTE: To modify all priority values in dialog box at once, fill in the Replace and 
With edit boxes with the desired numbers, and click Update All.

Deadline

Deadlines can be changed for a composite file, or each separation layer.

■ Composite File Deadline - There is a checkbox for the Composite file. By 
clicking the checkbox, the time and date fields can be edited.

■ Inks Deadlines - There is a checkbox for the Black, Cyan, Magenta, and 
Yellow ink layers in the file. By clicking the checkbox, the time and date 
fields can be edited.

Manual Changes
Multiple Pages

You can change the priority and deadlines for multiple pages by first selecting 
two or more pages, right clicking, and selecting Manual Changes. The pages 
will be identified at the top of the Manual Changes dialog box.

■ The priority of each layer can take any value from 2 (lowest priority) to 127 
(highest). The priority value defaults to 63 if there are different priorities per 
page. To change priorities, you can use the number boxes, or the slider. If you 
want to modify all priority values in this dialog box at once, fill in the Replace 
and With edit boxes with the desired numbers, and click Update All.

■ Deadlines can be changed for multiple files or layers in the files.

Composite File Deadline - There is a checkbox for the Composite file. By 
clicking the checkbox, the time and date fields can be edited.

Inks Deadlines - There is a checkbox for the Black, Cyan, Magenta, and 
Yellow ink layers in the file. By clicking the checkbox, the time and date 
fields can be edited.

Approve With permission, selected pages can be approved by page or layer.

Approve
Advertising

With permission, advertising for the selected pages can be approved by page or 
layer.
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Approve Editorial With permission, all editorials for the selected pages can be approved.

Hold Selected page(s) or layer(s) in an edition can be held. When clicked, the Unhold 
All pages dialog box is displayed.

Unhold Previously held page or layer can be released. Scanning for input in a particular 
folder is stopped, turning off the value of input until released. When clicked, the 
Unhold All pages dialog box is displayed.

Rename Output Rename Output allows you to add a prefix or suffix to a file or files if a print site 
system requires them.

Retransmit Selected page(s) or layer(s) can be retransmitted.

Cancel
Transmission

Cancels transmission of a plan to print sites.

Kill Page Cancels any planned transmission of a file and removes it from the Courier 
system. Pages, layers, or versions can be killed.

Clear Page Clears the selected page(s) or layer(s).

Copy Makes a copy of the selected file.

Cut Used to cut an individual file.

Paste Pastes a copy of the selected file into a new location.

■ Rotate Left allows you to rotate the Soft Proof in 90-degree increments to the 
left, which can be useful for viewing paired pages.

■ Mirror is primarily used when the production process includes a film output. 
When clicked, allows for wrong-reading separations.
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■ Flip allows for wrong-reading separations to be flipped.

■ Negate allows for positive viewing of negative separations.

Select All All files in the Unplanned folder are selected.

Soft Proof

When Soft Proof is selected from the main menu or shortcut menu, a separate 
window opens if the soft proof file is a JPEG. As many as two soft proof windows 
can be opened at a time, and then the windows will be reused. When a Soft Proof 
window is initially opened, the composite view of the page displays.

Drop Down List A drop down list button in the toolbar is used to view other soft proofs already 
generated for the edition.

Separation Tabs Separation tabs display composite, black, cyan, magenta, and yellow colors. If 
the configuration allows, click on a separation tab to change the soft proof from 
a composite to a separated view.

NOTE: If separation tabs do not display, the web configuration has been set to 
only display a composite view.

Toolbar The Soft Proof toolbar has tools that control closing the display, refreshing, 
printing, zooming, approving, rotating, flipping, and negating the display.

■ Refresh will revert the soft proof view back to the original (e.g., after it has 
been rotated or flipped), and will cause the view to be completely refreshed.

■ Hand Tool is used to grab the image and shift it in the direction the mouse is 
moved.

■ Fit To Window adjusts the soft proof to fit the window.

■ Full Scale adjusts the soft proof to 100% zoom.

■ Zoom % shows the percentage of zoom after clicking the Zoom In or Zoom 
Out buttons. The range goes from 5.000 to 1000.000 pixels or inches. These 
values can also be entered in the Zoom % box.
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■ Zoom In increases the soft proof size by 20% per click.

■ Zoom Out decreases the soft proof screen by 20% per click.

■ High Resolution Soft Proof - Opens a high resolution soft proof.

Select the region of interest. At this point the high resolution data will be 
combined to create the soft proof. A new window opens to display this proof. 
While the data is being generated, a progress bar will display the status. Once 
the soft proof is on the screen, you will be able to zoom in and out, and turn 
off selected layers. Clicking Close will return you to the standard soft proof.

■ Rotate Right allows you to rotate the Soft Proof in 90-degree increments to 
the right, which can be useful for viewing paired pages.

■ Rotate Left allows you to rotate the Soft Proof in 90-degree increments to the 
left, which can be useful for viewing paired pages.

■ Mirror is primarily used when the production process includes a film output. 
When clicked, allows for wrong-reading separations.

■ Flip allows for wrong-reading separations to be flipped

■ Negate allows for positive viewing of negative separations.

■ Densitometer checks the color density of the soft proof.

When the Densitometer button is clicked, the Densitometer RGB box 
shows the same color as currently covered by the cursor.

■ Approve has two options:

Approve Advertising: All Colors and Selected Colors.

Approve Editorial: All Colors and Selected Colors.

NOTE: When the Selected Colors option is chosen, a dialog box appears with 
CMYK and check boxes to approve the color.

■ Export Soft Proof Images - Opens the Save dialog box for exporting soft 
proof images. Refer to “Soft Proof Options” on page 22.

■ Print will display the Print dialog box. Select the printer to output the page.
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NOTE: Although the print range option defaults to All pages, it will only print the 
selected page. The image printed is the Soft Proof *.jpeg file, scaled to the paper 
size.

■ Close closes the Soft Proof Window.

Destinations

The Destinations displays a group of icons representing each configured site. 
Right-click on a site to see the shortcut menu.

Hold Selecting Hold puts the selected destination on hold so that it cannot receive 
transmitted files until hold is released.

Add to Queue View The Queue View shows files awaiting transmission, transmitting, and transmis-
sion complete with the last time period. Checking the Add to Queue View box 
adds the destination to the Queue View as a tab. Unchecking the box deletes the 
tab.

Unprocessed Files Pane

Unprocessed files consist of unplanned files and duplicate files. The Unproc-
essed Files pane contains two tabs: Unplanned and Duplicates.

Unplanned If unplanned files are received, they will display under the Unplanned tab in the 
Unprocessed Files pane. Depending on permission levels, right-clicking on a file 
in the Unplanned tab displays a shortcut menu with these options: Soft Proof, 
High Resolution Soft Proof, View PDF, Copy, Cut, Paste, and Select All.

Soft Proof

The Soft Proof window opens, and displays a soft proof of the selected file.

High Resolution Soft Proof

Selecting this option opens a High Resolution soft proof.
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View PDF

The source input PDF file is displayed.

Copy

A copy is made of the selected file.

Cut

An individual file is deleted.

Paste

A copy of the selected file is pasted into a new location.

NOTE: If set under “General Tab” on page 25, a prompt will display asking “Are 
Your Sure” so you can confirm the deletion.

Select All

All files in the Unplanned folder are selected.

Duplicates If duplicate files are received, they will display under the Duplicates tab in the 
Unprocessed Files pane. Right-clicking on a file in the Duplicates tab displays 
a shortcut menu with these options: Soft Proof, High Resolution Soft Proof, 
View PDF, Accept, Ignore, Delete, and Select All.

Soft Proof

The Soft Proof window opens, and displays a soft proof of the selected file.

High Resolution Soft Proof

Selecting this option opens a High Resolution soft proof.

View PDF

The source input PDF file is displayed.
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Accept

Accepts the duplicate file.

Ignore

Used to change the file to an ignored state.

Delete

Deletes the duplicate file.

Select All

All files in the Unplanned folder are selected.
Arkitex Courier Quick Reference Guide



CHAPTER

CG+0952650001.book  Page 59  Monday, January 8, 2007  6:50 PM
7 Plans

This chapter explains how to import a publication plan into Courier. Plans can be 
generated using Arkitex Planner, Arkitex Publication Builder, or AutoPlan.

Accepted Plan Formats

Arkitex Courier allows users to distribute plans and files to remote sites. Courier 
uses MAXML, which generates a .pmd format (Publication Builder), or .xml 
format (Planner).

Inputting Plans into Courier

The editorial site creates plans using Arkitex Planner, Publication Builder, or 
AutoPlan. Plans are stored in input folder(s) configured in Tools > 
Configuration > Input by the system administrator.

When the Input button on the Client interface is enabled, the Courier engine 
monitors the folder(s) for new plans.

When plans are located, they appear in the Plans node on the Publication Tree.

Arkitex Planner

For more information on Arkitex Planner, refer to the Arkitex Planner User 
Guide on the Arkitex Applications CD.

Arkitex Publication Builder

For more information on Arkitex Publication Builder, refer to the Arkitex 
Workflow Reference Guide on the Arkitex Workflow Products DVD.
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Arkitex AutoPlan

AutoPlan is used to automate the planning process for Director, Foundation, or 
Pair by converting data from a variety of planning systems into the standard 
MAXML data format.

Functions AutoPlan performs two functions:

■ It is a framework into which plug-in interfaces from various planning systems 
are delivered.

■ It allows different plug-ins to be developed for specific systems.

Basic Operation The basic operation of AutoPlan with Director, Foundation, and Pair is:

■ The product is planned using planning software.

■ AutoPlan reads or receives the plan in the planning system’s native data 
format.

■ AutoPlan converts the planning data and, using the default data, creates the 
MAXML data for Director. This plan includes altering the expected file names 
to match the user’s editorial system.

■ AutoPlan writes the MAXML data to Director.

Planning Systems The method used for receiving data depends on the style of planning system 
used. These styles can be broken down into three categories: Query, Export, and 
Interactive.

Query

AutoPlan queries the planning system for plan information. The query returns 
information for a planned edition.

Export

An Export system writes plan data to a disk file. AutoPlan receives the plan 
information in the disk file and converts the file into the expected MAXML 
format.
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Interactive

The user must communicate with the planning system. The system provides a 
list of planned editions. From this list the software requests plan information for 
a selected edition. This plan is converted into the expected MAXML format.

AutoPlan Tiers AutoPlan is divided into two tiers of functionality:

■ Tier 1 - One-way data flow with AutoPlan receiving plan data from a 
planning system and writing that data to the Arkitex server.

■ Tier 2 - Two-way data flow is customized to the user’s needs.

Supported
Planning Systems

AutoPlan supports a number of planning systems, including, but not limited to:

■ PPI PlanPag 2.5

■ ABB MPS3 2.21

■ ABB MPS3 3.01

■ Rockwell Automation PrintLogix V03_2002_06_30_00

■ GOSS EPAR Version 1

■ EAE Print 3 and 4 using the Print Production Export Version 2.3.1

■ Man Roland PECOM
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